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   1. Accessing the Graduate School Internet Portal Service `

YONSEI UNIVERSITY GRADUATE SCHOOL  

■ Accessing the Graduate School Internet Portal Service (http://portal.yonsei.ac.kr) 
    [Log in will be available on 2019.1.26.(Sat) after 09:30am]

1. Go to http://portal.yonsei.ac.kr. Move the cursor to "Academic Information System". Click on 
"Academic Management System (Degree Programs)".

2. Type in student ID and Password
   (Initial password is the 6 digits of birthdate in YYMMDD order)
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   2. Printing Admission Certificate
YONSEI UNIVERSITY GRADUATE SCHOOL  

■ Log in to Graduate School Internet Portal Service (http://portal.yonsei.ac.kr) 
   Click on '학적 (Student Record Management)' menu on left side of the screen -> Click on '증명' 

-> On the screen below click '출력'
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   3. Tuition Payment Guidelines `

YONSEI UNIVERSITY GRADUATE SCHOOL  

I. Tuition Payment

 1. Tuition Payment Process

What To Do Dates and Notes

Select Miscellaneous 
Fee(s) to Pay

2019. 1. 28(Mon) 09:30 ~ 1. 29(Tue) 16:00

↓

￭ Please mark ✓ for a miscellaneous fee(s) you wish to pay at Yonsei 
Portal Site (http://portal.yonsei.ac.kr), which is possible only during 
the period stated above. The payment will be made along with the 

tuition fee during the tuition payment period. 

Print Tuition Invoice 2019. 1. 30(Wed) 09:30 ~ 2. 1(Fri) 17:00

↓

￭ During the period of miscellaneous fee selection, you are able to 
print out the invoice by clicking ‘Print the Bill' button only after 

selecting miscellaneous fees to pay.
￭ Go to http://portal.yonsei.ac.kr/ → Click on "Tuition and Payment" 

located on the bottom of the page → Login by typing in ID and 
password → Click "Registration" → Click "Tuition Invoice Print" → 

Click Inquiry/Registration → Click "Print"

Pay Tuition Fee (and 
Miscellaneous Fee(s))

2019. 1. 30(Wed) 09:30 ~ 2. 1(Fri) 17:00

￭ Failure to pay tuition and/or other fees during above period will 
result to cancellation of admission. 

￭ Tuition can be paid via internet banking, phone banking, ATM 
transfer and teller transactions from all banks to designated Woori 

Bank account.
￭ We recommend that you complete the payment by 16:00 on 

February 1st, before the bank closes in order to avoid unexpected 
problems, 

such as transaction limit excess.
￭ ·Tuition Fee Table (reference) :

  http://www.yonsei.ac.kr/en_sc/admission/tuition.jsp
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 2. What is Miscellaneous Fees?

   A. Overview of Miscellaneous Fees

Item Amount(₩)
Paid 

Semester
Related 

Association 
Contact

Graduate Student 
Association Fee 11,000 Every 

semester

Graduate School 
Student 

Association
02-2123-3671

·The association works to enhance the graduate students' welfare and 
rights. Its main activities include academic supports through special 
lectures, conferences and more , issuance of a newspaper and the 
design and distribution of student pocketbook.

http://www.gradyonsei.com/
Student Health 

Mutual-aid 
Association Fee

22,500 Every 
semester

Student Health 
Mutual-aid 
Association

Sinchon:
02-2123-3350,2

Wonju:033-760-5430
·The association refunds a part of medical and medicine fees paid to any 
of local hospitals. Those who paid for this fee are also entitled to a 
discount at Yonsei University Health Service Center. 

http://web.yonsei.ac.kr/health/

Yonsei Coop 
Investment 5,000 1st semester

Yonsei 
University Coop 

Goods
02-2123-4038

·The Coop seeks to improve its unionists' welfare. It grants a Coop 
scholarship, provides part-time opportunities and pays dividends (if 
there's a surplus). The investment paid will be returned when the status 
as a unionist terminates.  

* Applicable only to the students in Sinchon Campus
https://www.yonseicoop.com/

   B. How to Select Miscellaneous Fees 
     Click "Registration" → Click "Print/Registration" → Click "Miscellaneous Fees Choice" → Click a 

miscellaneous fee(s) you wish to pay after copying the sentence starting with "I understand..." 
in the middle of the screen → Click "Print the Bill" 

   C. Note
     1) Selection and correction of miscellaneous fees is only possible during the designated 

period. [2019. 1. 28(Mon) 09:30 ~ 1. 29(Tue) 16:00] 
     2) During the designated period, you can correct the selection of miscellaneous fees after 

clicking 'Temporary Save'. However, no correction is possible after you click  'Print the 
Bill'. 

     3) Tuition Waivers and Scholarships do not appear on the menu of 'Miscellaneous Fees 
Choice'. Please go to the 'Browse/Registration' menu to check on them. 
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3. How to Pay Tuition

  A. Tuition fee must be transferred to an individually assigned virtual Woori Bank account in one 
installment. 

    1) Each student gets an individual virtual Woori Bank account number. When the students have 
transferred money to their virtual Woori Bank account, (even if the name of remitter is 
different from the student’s name) the student will automatically be enrolled.    

  B. Credit card payments can only be made by Woori Bank credit cards (debit cards and 
corporate cards cannot be used). 

     ※ Payments can be made at nationwide Woori Bank branches or through the Woori Bank 
website (http://card.wooribank.com). You can call the Woori Bank customer service center 
at 1588-9955 for further information.  

  C. Wire Transfer 
    1) If you are not able to pay tuition fee by any of methods stated above due to some 

conditions such as living abroad, please pay it by wire transfer.
    2) Since only one time payment is allowed, please consider the exchange rate and other 

charges for transferring the money. If the money transferred is more than the tuition fee, 
the rest will be refunded during your 1st semester. 

Bank Information
· Name of Bank(branch) : Woori Bank (Yonsei University branch)

· Recipient : Yonsei University
· Swift Code : hvbkkrsexxx

· Bank Address : 50 Yonsei-ro, Seodaemun-gu, Seoul 120-749, Korea

 4. Entrance Fee Waiver

   A. Please refer to the table below for the eligibility. The tuition amount indicated on the  invoice 
reflects the waived amount and is the fee you must submit.  

      * Go to http://portal.yonsei.ac.kr/ → Click on "Tuition and Payment" located on the  bottom 
of the page → Login by typing in ID and password (ID: Your student number; Password: 6 
digit date of birth, YYMMDD) → Click "Registration" → Click   "Print/Registration" → Click 
"Browse/Registration" → Click "Print the Bill" and check  the amount of entrance fee on the 
pop-up invoice.

   B. Please contact the graduate school office(tel. 82-2-2123-3229) before you make a payment if 
you believe the invoice reflects the wrong amount. 

Full Waiver Half Waiver
￭ For those who have been admitted as 

research program students at Yonsei 
University Graduate School(YUGS) or who 
have achieved Master's degree from YUGS 

AND 
advance to higher degree program at YUGS.

￭· For those who have graduated from or 
are enrolled at YUGS and enter into a 

different department of YUGS.

·￭ For those who have completed research 
program at or achieved Master's or 

Doctoral degree from any of professional 
and/or specialized graduate schools at 
Yonsei University and enter any one of 

department of YUGS   
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5. Verification of Tuition Payment

  To verify your tuition payment, go to http://portal.yonsei.ac.kr/ → Click on "Tuition and  
Payment" located on the bottom of the page → Click "Registration" → Click "Print/Registration" → 
Click "Print Payment Verification"

6. Entering Personal Bank Information

  A. Please register your personal bank account number to Yonsei Portal Site. Your bank  
information is necessary for granting scholarships, returning the tuition balance and more.

  B. In case the name registered at Portal Site and the name of account holder are not exactly the 
same, bank account number may not be able to get registered at Portal Site. In that case, 
please send the copy of your bank account and a copy of your student ID card to the office 
of Graduate School(chan0214@yonsei.ac.kr). You can also visit the graduate school office 
(Stimson Hall 2F ) and submit the copies.

  C. How to Register : Go to http://portal.yonsei.ac.kr/ → Click on "Tuition and Payment"  located 
on the bottom of the page → Login by typing in ID and password (ID: Your  student number; 
Password: 6 digit date of birth, YYMMDD)→Click "Student Record" → Click "Information" → 
Click "Personal Data" → Find 계좌정보 and Click "Modify" → Input your bank information → 
Save.
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Graduate School Tuition Fee Payment Guideline

1.  Go to portal.yonsei.ac.kr  → Click on "Tuition and Payment" located on the left hand of the 
page

2. Log In : Typing in ID and password (ID: Your student number, Password: 6 digits of date of 
birth, YYMMDD) 
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3. Select Miscellaneous Fees : Click "Registration" → Click "Print/Registration" → Click 
"Miscellaneous Fees Choice" → Click a miscellaneous fee(s) you wish to pay → Click 
"Miscellaneous Fee Confirm" 

4. Printing the Bill  : Click "Registration" → Click "Print/Registration" → Click "Print the bill"
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5. Tuition Fee Payment: Tuition fee shown in the individually assigned virtual Woori Bank 
account must be paid in one installment. 

   - Each student is given an individual Virtual Woori Bank account: When the students remit money to their 
virtual Woori Bank account, (even if the name of remitter is different from the relevant student’s name) 
the student will automatically be enrolled.  

6. Verification of Tuition Payment : Click "Registration" → Click "Print/Registration" → Click 
"Print Payment Verification"
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   4. Guidance for Student ID Card Issuance
YONSEI UNIVERSITY GRADUATE SCHOOL  

1. Student ID card is issued for the convenience of students in Yonsei. It can be used as 
identification card and for other purposes such as UniCheck card, entering library and dormitory, 
and checking attendance at classes.

2. Issuance Candidate: Newly accepted graduate school students

3. Application 

   Step 1. Log in to the portal website (ID: Student Number / Password: 6 digits of date of   

   birth (YY/MM/DD)→ Academic Information System→ Issue Student ID→ 재발급 신청   
   ID card reissuance→ 개인정보 제3자 제공 동의(Personal Information Release Consent)  
   → Confirm

  ※ Important Notes 
    1) International Students must apply for a student ID from the re-issuance period through 

the portal site.

4. Application Date

5. Expected Time for an Issuance : Minimum one week

6. Student ID Card Distribution 

   ￭ Sinchon Campus :
       2019. 3. 4.(Mon), 3. 5.(Tue), 3. 6.(Wed), Woori Bank at Sinchon Campus (09:00~20:00)
   ￭ International Campus :
       2019. 3. 4.(Mon), 3. 5.(Tue), 3. 6.(Wed), Woori Bank at International Campus (09:00~20:00)
  ※ Please visit Woori Bank with your identification card or passport. 
  ※ After the distribution date, please visit Woori Bank at Sinchon Campus or Int'l Campus in 

order to pick up your Student ID Card. (09:00~16:00)

7. Contacts

   • Student Service Center (General Consultation) : 02-2123-3205
   • Student Service Center (Technical Consultation) : 02-2123-7468
   • Woori Bank (International Service) : 1599-2288
   • Woori Bank (Wibee Service) : 1644-5000 

Type Date Note

International 
Students

Available from 
2.19(Tue) 10:00 

at the portal website

-Service is only available from the stated 
date
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￭ You are required to register for courses via Yonsei portal (http://portal.yonsei.ac.kr) during the 
course registration period. This is not for the current semester, but for the upcoming semester.

￭ Under Article 21, Section 2 (Academic Probation) of the University Statutes and Regulations, 
students shall be placed on academic probation if their GPA falls below 2.0, and if they are on 
probation for two semesters in total, they will be academically dismissed. Students may be 
readmitted after dismissal, however, if they fail to meet the GPA requirement once again, they will 
not be able to apply for readmission. Please bear this in mind and enroll for your courses after 
full consideration. 

 
※ International students (who do not hold a Korean citizenship) will not be able to register for 

courses until they upload their Certificate of Insurance on Yonsei Portal. 
   (http://portal.yonsei.ac.kr, tel: 2123-3228 ) Academic Information System → Academic 

Management System → Student Record → Information → Insurance (jpg format only) (Please 
refer to page 19 for detailed information)

I. IMPORTANT INFORMATION

1. Registration Period for New or Current Students (Graduate and Supplementary Courses) 

     - 2019. 2. 11(Mon) - 2. 15(Fri) 
       * Online registration hours are from 10:00 to 23:59.  

2. Add/Drop Period (Graduate and Supplementary Courses)

     - 2019. 3. 7(Thu) - 3. 11(Mon)
       * Online registration hours are from 10:00 to 23:59.

3. Course Selection

    A. Course Catalog and Syllabus
You can browse our course catalog and view syllabi on Yonsei Portal.

        http://portal.yonsei.ac.kr
        ￭ Main Portal Service → Course Catalog and Syllabus: Undergraduate & Graduate
        ￭ Academic Information System → Academic Management System → Course → Course 

Catalog 
          1) Changes to Courses: Changes made to the timetable during the registration period will 

be marked in blue. 
          2) Syllabus: Click on the purple arrow/note icon next to the course title to read the 

course syllabus.
    B. Credits
      1) How to check the number of credits you have earned 
        ￭ Go to Yonsei Portal (http://portal.yonsei.ac.kr) → Academic Information System → 

Academic Management System → Login → Student Record → Information → Grading 

   5. Course Registration 
YONSEI UNIVERSITY GRADUATE SCHOOL  
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Browse → Below the field heading “PSD (PASSED)“ is the total number of credits you have 
earned.

Degree
Minimum Number of Credits 

Required for Graduation
Minimum GPA Required 

for Graduation
Note 

Master's* 30 credits
3.0/4.3 (B0) or higher 

Minimum credit 
requirement for graduation 
may vary by departments.

Doctoral 30 credits
Joint 54 credits

       * : including students who have withdrawn from Joint Degree programs

        ※ Even though you register to audit a Major or credit course, it will count towards the 
number of credits you are allowed to take per semester. Those who are taking an 
additional semester will be charged for the extra credits. (For detailed information, please 
refer to “4. Important Notes”) 

        ※ Audited or supplementary courses with credits do NOT count towards the credit 
requirement for graduation.

      2) Directed Research Course (Non-credit) 
Under Article 2 of the Graduate School Thesis Regulations and Policies (submission 
requirements), students whose proposal has been accepted (or will be accepted in the 
upcoming semester) must enroll in Directed Research courses. 

     

Degree Regulations Course Title

Master's* After your proposal is approved, you should register for 
"Directed Research 1" course at least for one semester.

"Directed 
Research 1"

Doctoral/ 
Joint 

After your proposal is approved, you should register for 
"Directed Research 2" course at least for two semesters.

"Directed 
Research 2"

* : including students who have withdrawn from Joint Degree programs

    C. Retaking a course 
     1) Courses with the identical code and/or title are considered to be the same; if you take the 

same course twice, it will count as a “retake”. In this case, only one of them shall be 
credited. When you register for those courses, a notice will be given in a pop-up window.

        ※ You are allowed to retake a course once if you wish to achieve a better grade.   
     2) The above rule does not apply:
    ￭ if you register to “audit“ the course (on a Pass/Not pass basis)
         ￭ if the course is a "supplementary" course (Undergraduate) whose title is the same as that 

of Graduate School
 ￭ if different departments offer courses with the same title

     3) PhD students: if you register for the same course you took while doing your Master’s at 
Yonsei University Graduate School, it will NOT be considered as a retake. However, it 
might not fulfill requirements toward graduation, so please check with your department 
first.  
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4. Important Notes

    A. Please make sure to select the right option for the type of course (eg. Major, Audit, 
Research, Supplementary).

    B. Graduate students (Degree program) can register for a maximum of 12 credits per semester 
(including supplementary courses). 

      ￭ Non-degree students may take up to 6 credits per semester. They need to select the 
"Research" option for graduate courses and the "Audit" option for undergraduate courses.  

      ￭ Students MUST check the time schedules for Intensive or Field Training courses. 
Soon-to-be graduates and KGSP (Korean Government Scholarship Program) students are 
allowed to enroll for those courses only if they are required to graduate.   

      ￭ Students registering for the online course in Research Ethics must log into Yonsei Portal 
(http://yscec.yonsei.ac.kr) to take the course. It opens on the first day of the semester and 
closes at 23:50 of the day (weekday) before the final exam period begins. 

    C. Please consult with your advisor or the head of the department before enrolling in courses. 
    D. Registration fo r Supplementary Courses
       1) Requirements for supplementary courses may vary among the departments; if you gained 

your previous degree in a different field of study than your current one, please contact 
your department before registration. The maximum number of credits you can take for 
supplementary courses is 12 in total.   

       2) You can register for supplementary courses via Yonsei Portal.
       3) You can choose to take those courses either on a supplementary (Graded) or an audit 

basis (Passed/Not Passed). They do not count towards the cumulative GPA or the credit 
requirement for graduation.           

    E. Registration for "Directed Research" Course
       1) Under the regulations set by the Graduate School Management Committee, since Spring 

semester 2003, Directed Research Course (I for Master’s candidates or those who have 
withdrawn from the Joint Degree program; II for Doctoral or Joint Degree candidates) has 
been automatically enrolled for students who are expected to graduate (Master’s and 
Doctoral candidates in their 4th or later semester; Joint Degree candidates in their 6th or 
later semester), Please check whether you are properly enrolled in the course during the 
registration period, and if your thesis proposal has not yet been accepted (or will not be 
in the following semester), you can delete it, 
※ If you meet your degree requirements earlier than your final semester, please submit 
the “Directed Research Registration Request Form” to the Graduate School Office during 
the course registration period in your third semester of Master’s* program, second 
semester of Doctoral program, fifth semester of Joint Degree program, respectively. 

         * : including students who have withdrawn from Joint Degree programs 

         (You need to contact your department to get the form and ask about the degree 
requirements.)          

       2) 12% of your tuition will be charged for an additional semester, provided that you only 
take the Directed Research course.  

    F. Your tuition fee for an extra semester (5th or later semester of Master's/Doctoral program; 
7th or later semester of Joint Program) will be charged according to the number of credits 
registered for. Please print your tuition invoice during the Additional Registration period.
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       1) Tuition fees  
           ① 0 credit: 12% of tuition
           ② 1-3 credits: 1/3 of tuition
           ③ 4-6 credits: 2/3 of tuition
           ④ 7 credits or more: full tuition
    G. You are required to take at least one course. If the course is canceled or you failed to get 

permission to take a supplementary course, please consult your department. Important 
notice about the course registration will be sent via email or text messages, so make sure to 
update your personal information on our portal (http://portal.yonsei.ac.kr) if there is any 
change. 

 ￭ Academic Information System → Academic Management System → Login → Student Record 
→ Information → Personal Data → Modify

    H. Credit Exchange Program (Cross-Registration) 
       1) You can enroll for courses in other specialized graduate schools of Yonsei University. 

You may take up to 6 credits per semester and 15 credits in total. Please note that the 
courses may NOT be audited. 

       2) Yonsei University Graduate School also has cross-registration agreements with other 
graduate schools in Korea. You may enroll in their courses as well; the courses may not 
be audited and credits will be awarded in accordance with the agreements with the host 
universities. 

       3) Under the agreement between three graduate schools located in Sinchon area, you can 
register for courses offered by Ewha Womans University or Sogang University via Yonsei 
Portal during the course registration period.  

          ￭ Choose “Ewha Womans university” or “Sogang University” in the list of departments. 
          ￭ The information about timetables and lecture rooms can be found on their websites.
            ① Ewha Womans University → Study Guideline→ Timetable/Syllabus → Graduate school
             (http://eureka.ewha.ac.kr/eureka/hs/sg/openHssg504024q.do?popupYn=Y&englishYn=Y)
            ② Sogang University → Graduate School → Information of Courses
             (http://sis109.sogang.ac.kr/sap/bc/webdynpro/sap/zcmw9016?sap-language=EN)
       ※ For the information about course registration in other graduate schools in Korea, please 

refer to the notice of our website (http://graduate.yonsei.ac.kr). If you wish to take courses 
at one of the universities, please submit the application form to the Graduate School Office 
before the deadline given in the notice. 

II. ONLINE COURSE REGISTRATION

 1. How to Register for Graduate Courses

   A. Go to Yonsei Portal (http://portal.yonsei.ac.kr) and click "Graduate Course Enrollment" on the 
Main Portal Service menu. (This service will be available from 10:00 am on the first day of 
the course registration period.)

   B. Login with your student ID and password (Default password: your date of birth in YYMMDD 
order). 

   C. Read the instructions carefully before you start. 
   D. Click on "Course Enrollment". The next page will show your department, major, and available 
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courses. You can register for a course by clicking on its code which is in blue. The list of 
enrolled courses will appear at the bottom of the page. To cancel your registration, you need 
to click on the code on the list. 

 2. How to Register for Supplementary Courses 

     (Refer to page 18-19 for detailed guidelines)
    A. Go to http://portal.yonsei.ac.kr → "Academic Information System" →"Academic Management 

System". 
    B. Login with your student ID and password (Default password: your date of birth in YYMMDD 

order). 
    C. Click “Course” on the left menu → “Undergraduate Supplementary Course” and read the 

notice carefully. 
    D. If you click on “Undergraduate Course Registration”, you can browse undergraduate courses. 

Select the program category, college and major first and then click “Browse” to check the 
list of courses available. You can request permission to take a course by clicking the note 
icon.   

    E. In order to view the status of your request, click “Result” on the left menu. 
    F. If you want to cancel your request, just click “X” button on the list of your supplementary 

courses. If you want to drop the course after the final approval is granted, you need to go 
to “Course” → “Course Enrollment” menu (graduate course) and click the blue course code 
on the list of your registered courses.  

    G. To see the final list of your supplementary courses (approved), go to “Course Enrollment” → 
Enrollment Status or “Graduate Course Enrollment”.

Ⅲ. IMPORTANT DATES 

    1. Course Withdrawal: 4.3(Wed) ~ 4.5(Fri)  
      ※ Withdrawn courses are marked W in the Transcript. 
      ※ Tuition is not refundable even in the case of course withdrawal
   2. Course Evaluation, Survey for Improvement of Research Environment & 

Graduate Programs: TBA

    3. Grade Confirmation & Request for Grade Change: TBA
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Supplementary Course Registration Guidelines 

1. General Information

  A. When you register for supplementary courses, you must comply with the regulations of 
your department. 

  B. No more than 12 credits, including supplementary courses, may be taken per semester.  
  C. The maximum number of credits allowed for supplementary courses is 12.     
  D. You should choose to take supplementary courses either on a supplementary (Graded; 

letter grade such as A+, B0 on the transcript) or an audit basis (Passed/Not Passed; P/NP 
on the transcript).

  E. Supplementary courses do not count towards the cumulative GPA or the credit requirement 
for graduation.   

2. Registration Period: Course Registration and Add/Drop Period 

  * Wonju Campus students can also enroll for courses via Yonsei Portal System

3. How to Register for Supplementary Courses

  A. Go to Yonsei Portal (http://portal.yonsei.ac.kr). Place the cursor on "Academic Information 
System" to click on "Academic Management System". 

  B. Login with your student ID and password (Default password: your date of birth in YYMMDD 
order).  

  C. Click “Course” on the left menu → “Undergraduate Supplementary Course” and read the 
notice carefully. 

  D. If you go to “Course Enrollment”, you can browse undergraduate courses. Select the 
program category, college and major first and then click “Browse” to check the list of 
courses available

* Please note that to register for Graduate courses you must go to “Graduate Course 
Enrollment” on the Main Portal Service menu. 
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 E. After selecting the course you wish to take and click the note icon . It will be added to 

the list of your enrolled courses at the bottom of the page. If you want to drop the course, 
click the icon   on the list again. 

 F. If you want to cancel your request, just click “X” button on the list of requested courses. If 
you want to drop the course after the final approval is granted, you need to go to the 
“Course Enrollment” menu and click the course code on the list of your registered courses.  

 G. Your request might not be approved either by your department or the Graduate School 
office for some reasons (e.g. regulations of the department, credit limit etc), so please make 
sure to check the status of your request – whether it is fully accepted or not - on Yonsei 
Portal. 

Approval Status Where to Drop Notes

 Request just submitted Undergraduate Supplementary 
Courses → Course Enrollment

You may not be able to drop 
courses while your request is 
pending approval
(To check the status of your 
request, click “Result” on the 
left menu)

Approved by the 
Department

Undergraduate Supplementary 
Courses → Course Enrollment

Approved by the 
Graduate School Office

Course → Course Enrollment → 
Enrollment Status
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   6. Insurance Policy for International Students
YONSEI UNIVERSITY GRADUATE SCHOOL  

1. Medical Insurance 
According to the regulations of the Korean Ministry of Education, all the international students 
(who do not hold a Korean citizenship) are required to maintain a medical insurance during their 
stay at Yonsei. Since 2017 Spring semester, international students are not be able to register for 
courses until they upload their Certificate of Insurance on Yonsei Portal. Please read the following 
guidelines carefully and upload your certificate before the deadline. 
※ KGSP students will be informed of this by email.   

2. Types of insurance (Choose one)
   1) Insurance Company affiliated with Yonsei University (Discount prices)
      - Company: Meritz Insurance 
                   (Agency: Cental Ins Korea http://n.foreignerdb.com/yonsei1) 
      - Insurance Fee: 102,000KRW (Male), 118,000KRW (Female) (for a year, TBC)
      □ Information for Newly admitted students

 Insurance coverage start date: February 23(SAT) 2019 (TBC).
 If you arrive in Korea before 23(SAT) February 2019, you are advised to purchase an 

extra travel insurance covering the period.       
   2) National Health Insurance 
      - National Health Insurance Corporation: http://www.nhic.or.kr, Tel 1577-1000
      - Newly admitted students will not be able to apply for NHI if they do not have an Alien 

Registration Number, so they need to arrange other type of insurance first and then apply 
for NHI later IF they want to. 

   3) Private Insurance from a company in your home country
      - It is allowed ONLY IF it covers you while you are in Korea
      - The certificate must include your personal information, policy period, coverage, etc. 

3. Submission (Deadline: January 31, 2019) 
   1) Yonsei Portal (http://portal.yonsei.ac.kr,) Academic Information System → Academic 
Management System → Student Record → Information → Insurance (JPG format only) 
      * Please upload the Certificate of Insurance in JPG file format
      * For National Health Insurance, please upload 건강보험자격득실확인서

       

   2) If you have any trouble uploading your document on the portal, please contact the Graduate 
School Office at ysgrad@yonsei.ac.kr / 02-2123-3228.
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4. How to Claim insurance payment(Agency: Cental Ins Korea http://n.foreignerdb.com/yonsei1) 
   A. Using KAKAO for claim

 1) Login on the website using your student number or Alien registration number or
          Passport number and password.

 2) Click the menu “my information” and click “Download Claim report.” 
          Print it out and fill out all the information.

 3) Search and Add our KAKAO ID
          (Korean, English Service: INSCLAIM / Chinese Service: CLAIMS)

 4) Prepare all the necessary documents for claiming.(Please refer to 5. Necessary
          documents for claiming.) Scan or take a picture individually and send them via
          KAKAO. The Pictures must be accurate and clear.
      5) If there is no problem with your document, you will get your payment within 
         minimum 3~5 days.(except weekend and holiday) The agency will contact you to 
         request additional document if any document is missing. 
   B. Using Website for claim
      1) Login on the website using your student number or Alien registration number or 
          Passport number and password.
      2) Click the menu “my information” and click “Download Claim report.”
          Print it out and fill out all the information.    
      3) Prepare all the necessary documents for claiming.(Please refer to 5. Necessary 
          documents for claiming.) Scan or take a picture individually and compress the
          file. Please upload it to “upload documents for claim.” 
      4) If there is no problem with your document, you will get your payment within 
         minimum 3~5 days.(except weekend and holiday) The agency will contact you to 
         request additional document if any document is missing.

5. Necessary documents for claiming(Agency: Cental Ins Korea http://n.foreignerdb.com/yonsei1) 
   A. Common documents
      1) Claim report + Personal data processing agreement(Download on website)
      2) Copy of your Alien registration card
      3) Copy of your bank book
   B. Inpatient treatment(Including surgery)
      1) Confirmation of hospitalization and discharging
      2) Receipt of treatment(not credit card receipt)
      3) Detailed statement of medical expenses
      4) Confirmation of Surgery(In case of taking surgery)
   C. Outpatient treatment
     * In case of the treatment fee is under KRW 30,000:
      1) Receipt of treatment(not credit card receipt)
      2) Detailed statement of medical expenses
     * In case of the treatment fee is more than KRW 30,000:
      1) Receipt of treatment(not credit card receipt)
      2) Detailed statement of medical expenses
      3) At least one of the following documents
        Medical records/outpatient confirmation/medical chart/doctor’s opinion paper
    D. Prescription(medicine)

 1) Prescription
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       2) Receipt of pharmacy(not credit card receipt)
 
NOTICE
※ In case of obstetrics and gynecology/ proctology / urology / dermatology, no matter how much
you paid, you must prepare Medical records or prescription which provide the name of disease.
(It must includes disease code or name)
※ In case of taking MRI or CT examination, you must prepare “MRI(CT) scan reading report.”

◆ Please refer to  http://n.foreignerdb.com/yonsei1 for more information.
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   7. Library Guide
YONSEI UNIVERSITY GRADUATE SCHOOL  

1. Library Webpage: http://library.yonsei.ac.kr
For more details about library services such as Library Catalog, Research Guide, Purchase Request,
Interlibrary Loan, and Document Delivery Service, please refer to the library webpage above.

2. Library Hours

Type Name During Semester During Vacation
Mon. – Fri. Sat. Mon. – Fri. Sat.

Central 
Library

24 hour Study Room(1F) Opens 24 hours

Privileges Office(1F) 09:00-17:00 - 09:00-17:00 -
Humanities Collections: Books(2F) 09:00-21:00 09:00-17:00 09:00-20:00 09:00-17:00

Social Sciences & History 
Collections: Books(3F)

Science & Technology Collections: 
Books(4F)

Korean Classics Collection(5F) 09:00-17:00 - 09:00-17:00 -
Graduate Study Room(5F) 06:00-23:00

Study Room 1(6F) Opens 24 hours 06:00-23:00
Study Room 2(6F) 06:00-23:00 -

Yonsei- 
Samsung 
Library

Y-Valley(1F) 08:00-23:00
Makerspace(1F) 09:00-18:00 - 09:00-18:00 -

Information Commons(2F)

09:00-21:00 09:00-17:00 09:00-20:00 09:00-17:00Multimedia Center(3F)
Research Commons: 

Journals, References(5F)
Makerspace(1F) 09:00-18:00 - 09:00-18:00 -

Grand Study Room(4F) 08:00-23:00
Cafe(8F) 08:50-20:00 09:00-16:00 09:00-17:00 -

Branch 
Libraries

Law Library
(Yonsei-Samsung Library 6F) 09:00-21:00 09:00-17:00 09:00-20:00 09:00-17:00

Music Library
(College of Music, New Bldg. 2F) 09:00-18:00 - 09:00-18:00 -

Underwood Memorial Library
(International Campus) 08:30-24:00 09:00-18:00 09:00-18:00 -

 ※ For more details about library hours, please refer to the library webpage.

3. Temporary access before student ID card issuance

 New students can receive a "Temporary Library Pass Card" with presentation of the tuition
 payment receipt and identity card at the Privileges Office(#108, Central Library). 
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   8. Yonsei Health Mutual-aid Association
YONSEI UNIVERSITY GRADUATE SCHOOL  

1. Website : http://web.yonsei.ac.kr/health
2. Sinchon Office : Student Center Rm. 206 (02-2123-3350, 3352)
3. Office Hour during Regular Semester : Mon-Fri 9:00-17:00 (Lunch 12:00-13:00)
4. Office Hour during Summer/Winter Breaks : Mon-Fri 9:00-15:00 (Lunch 12:00-13:00) 
5. The Yonsei Health Mutual-Aid Association Qualification for Membership: 

  ￭ Membership is exclusive to Yonsei University Undergraduate and Graduate students.
   (Not applicable to family members)

Classification Availability of Deduction
Available Period of 
Deduction & Limit 

Period Limit

    Current Students
Available if signed-up as members 

of the Mutual-aid through 
registration or optional payment

Relevant
semester 
(Receipts 
should be 
submitted 

by the end 
of the next 
semester)

Registration
: 

Spring
Semester
Mar 1st~ 
Mar 31st

Fall
Semester
Sep 1st~
Sep 30th

1million KRW
including
outpatient
treatment 

and 
hospitalization

Students 
on 

Leave
of

Absence
 

Unregistered student 
on leave of absence Available if signed-up as members 

of the Mutual-aid through 
registration

Students on leave
of absence with full

refund of tuition
Students  on a 

leave of absence 
within 90 days  

from the start of 
semester

Available if signed-up as members 
of the Mutual-aid through 

registration or optional payment

Outbound
Exchange Students

Available during relevant semesters 
as exchange students if signed-up 

as members of the Mutual-aid 
through registration
Registration period

1st semester: March 1 ~March 31
2nd semester: September 1 

~September 30

Undergraduate students
of Wonju Campus

taking an extra semester 
(students only

attending chapel)

Available during relevant extra 
semesters if signed-up as members 

of the Mutual-aid through 
registration

Registration period
1st semester: March 1 ~March 30

2nd semester: September 1 
~September 30

6. Semesters: Spring Semester: March 1 - end of August
                   Fall Semester: September 1 - end of February (following year)
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7. Becoming a Member

  1) Optional Payment
     Membership for Mutual Aid Association has become optional since 2013 Spring semester. You 

become a member by paying KRW 22,500/per semester. Students who did not pay the optional 
fee can also become a member association by separate means. 

  2) Membership
  ￭ Sinchon Campus ․ International Campus
   1) Undergraduate, Graduate students (including professional and specialized school) 
      (For students who did not pay optional fee during registration period)
   2) Students on leave of absence  
   3) Exchange students (Students participating exchange program conducted by Yonsei University's 

Office of International Affairs : Exchange, Visiting, GIP, SA) - Only Outbound Exchange 
Student are Allowed ; Inbound Exchange Student are NOT Allowed.

  ￭ Wonju Campus
   1) Undergraduate, Graduate students 
      (For students who did not pay optional fee during registration period)
   2) Students on leave of absence  
   3) Exchange students (Students participating exchange program conducted by Yonsei University's 

Office of International Affairs : Exchange, Visiting, GIP, SA) - Only Outbound Exchange 
Student are Allowed ; Inbound Exchange Student are NOT Allowed.

   4) Undergraduate students taking NP classes 

8. Sign-up Period : Sign-up will not be allowed after this period
  ￭ Spring Semester: March 1 ~ March 31 (During Office Hour)  
  ￭ Fall Semester: September 1 - September 30 (During Office Hour)

9. Location and Requirements : Mutual Aid Association (walk-in sign-up / Account transfer)
  ￭ Student ID, Membership fee (KRW 22,500, Only cash allowed)
  ￭ It is possible to sign up for other people, so if you are signing up for other students, please 

bring his/her student ID card and membership fee. 
  ￭ Account information will be noticed during sign-up period

10. Students on Leave of Absence Application

    Due to change as optional payment, when tuition fee is refunded membership fee will not be 
refunded (unless the student has applied for leave of absences before the final enrollment 
date) 

  ※  Students on leave of absence 
      As the Mutual-aid Association fee became optional, it cannot be refunded for students on 

leave of absence. (However, students who took leave of absence before the final registration 
period can get full refund.)

  ※ For detailed information on tuition and Mutual-aid Association fee, please refer to the 
academic schedule. 
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 11. Materials to Prepare and Method of Deductions Application

  ① Treatment (medical expenses) Original Receipt: Payment (Insurance), Record of the division of 
Non-Payment (No Insurance) format, Treatment Date and Treatment Dept. (Copies will not be 
accepted) 

  ② Student ID Card of Yonsei University (or Statement of Enrollment)
  ③ Woori Bank Account Number of the Student (No need to copy account booklet – just record 

the account number)

Classification Campus Place Contact

Register
by

visiting

Sinchon
International Sinchon Campus Student Center Rm. 206 02-2123-3350,2

Wonju

Wonju Campus Student Center Rm. 242
(Receiving Box prepared in front of the 

Student Association Office in Wonju 
Medical School)

033-760-2682

Register
by Mail

Sinchon
International

Mutual Benefit Association for Student 
Health,

Rm. 206, Student Center of Yonsei 
University,  Shinchon-dong, 

Seodaemun-ku, Seoul  

 

Wonju

Mutual Benefit Association for Student 
Health,

Rm. 242, Student Center of Yonsei 
University,  Yonseidae-gil 1 Wonju 

Kangwon Province

 

   * When the three items above are prepared, registration by proxy is possible / Registration is 
possible regardless of affiliation at Sinchon, Wonju, or the International Campus.

  * Students in International Campus can register by mail

12. Available Hospitals / Range of Available Deduction

   ￭ Available Hospitals : Any hospital located in Korea (Oversea Hospitals are excluded) 
   ￭ Range of Available Deductions : Limited to insurance payment of treatment expenses
                                    (Non-Insured Treatment is excluded)

        Subject
Treatment   

Mutual Benefit Association

1st Treatment Institution
(Private Clinic) Student Payment’s 50%

2nd Treatment Institution
(Hospital level) Student Payment’s 40%

3rd Treatment Institution
(General Hospital) Student Payment’s 30%

3rd Treatment Institution
(Special General Hospital) Student Payment’s 20%

School Health Center 90%
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 ※ Non-Insured Treatment: National Health Insurance Corporation designated illnesses, delivery, 
non-life-threatening injuries or those not encumbering one’s job or daily life as items not 
covered by the standard insurance plan to limit financial issues and to maintain fairness of 
social insurance payments. Typical examples of non-insured medical treatment are 
orthodontia, plastic surgery for beauty treatment, surgery for eyesight correction, diet and 
skin care. For details on insurance payment/non-payment, please inquire at the hospital where 
you receive the treatment.

  ※ The deduction shall not exceed the actual insurance payment of one’s share. 

13. Contact to Yonsei Health Mutual-aid Association

    - Homepage: http://web.yonsei.ac.kr/health
    - Sinchon Office: Student Center Rm. 206/ 02-2123-3350,3352
    - Wonju Office: Student Center Rm. 242/ 033-760-2682
   * Please contact the relevant office for other inquiries.

(In the case you have paid both 
Student Health Mutual-aid 

Association Fee AND Health 
Expenses)

        Subject
Hospitalization

Mutual Benefit Association

Every Institution Student Payment’s 30%
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1. Eligibility and Selection Method
  A. Eligibility (Must meet all the requirements)
     1) 2019-Spring Semester freshmen enrolled in general or specialized graduate school in
       Sinchon Campus
     2) Local(outside of Seoul), Overseas Korean : based on the parents’ residence
       OR International students   
  B. Selection : Computerized Random Selection
  C. Important Notice
     1) Law school students and general graduate school’s law major students can only apply for 

Buphyeon
     2) Information of dormitories for medical institution-related departments
        A) Medical college graduate students can only apply to Jejung dormitory.(CONTACT 02-2228-2700)
        B) Graduate students of dental and nursing colleges can apply to Muak #3
     3) Wonju Campus students are not available to apply for Sinchon Campus dormitories.
         Those students must apply to the dormitories in Wonju campus.
     4) Students who have received 16(or more than 16) penalty points in Songdo Campus OR
        Students who have been forced to move out from the dormitory in Sinchon CANNOT apply.
     5) Students are NOT allowed to apply for more than 1 dormitory in Sinchon campus. 

2. Dormitory fee and Guide for facility

  

Building
Number

Per 
Room Gender/Other Cost

Room 
dimensi

ons 
(m2)

Showers/
Rest room Community Facilities

Muak #1 Twin
Male

(undergraduate)
794,390KRW 13.52

per floor/ 

with shared

Lounge, Gym, Study room, 

Coin Laundry, Computer room, 

Seminar room.

Muak #2 Twin
Female

(undergraduate), 
(graduate)

833,940KRW 13.52
per floor/ 

with shared

Lounge, Food court(Muak #2), 

Store(Muak #2), Gym, Study 

room, Laundry, Coin laundry

Computer room, Prayer room.

Muak #3 Twin
Male & Female  
Dental, nursing 

College 
857,670KRW 14.11

per floor/ 

with shared

Lounge, Convenience store, 
Studyroom,Gym, Coin laundry, 
Computerroom, Chapel,,Prayer

room.,Self kitchen

Muak #4
(A, B1F)

(Exclusion of Testers)
Twin

#A- male (graduate)
#B F1-Female 

(graduate),(undergraduate)

888,180KRW 14.11
per floor/ 

with shared
Lounge, Gym, Yoga room, 

Study room, Coin Laundry, 

Computer room, Self kitchen.Muak #4B,  
Foreigner(2~5F)

Single
Foreigner,

 Overseas Korean

- undergraduate

& graduate

2,005,750KRW 21.25 Per room

Twin 1,337,920KRW 28.42 Per room

Muak #6

(Woojungwon)

Twin
Male & Female 
(undergraduate)

1,337,920KRW 22.47 Per room Community lounge, Gym, 

Study room, Coin laundry, 

Prayer room, Seminar room, 

Self kitchen
Triple 854,280KRW 22.47 Per room

Beophyeon Twin
 Law school students/
 Male&Female

 (graduate)General&Special

1,337,920KRW 22.80 Per room

Convenience store, bakery, 

Gym, Study room, Coin 

laundry, Seminar room, 

Lounge

 

 9. Application Guidelines for Muak Dormitory

YONSEI UNIVERSITY GRADUATE SCHOOL  
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※ The length of a Woojungwon triple room’s bed is about 10cm shorter than the length of a single bed.
※ The cost may be re-announced after revision in the early 2019.

3. How to Apply 

 A. On-line Application Period : 2019. 1. 2.(Wed) 10:00 ~ 1. 3.(Thu) 23:00

 B. How to apply : Complete online application form via the pop-up page of Housing website
                    (http://web.yonsei.ac.kr/housing) 
 C. Additional application plan for students who did not apply or who are on a waiting list   
   : The notice will be posted in the early February 2019. The waiting list will fill the vacancy
     at any time.
  

4. Required Documents(application is canceled when not submitted)

 A. How to submit : Visit the Housing office during office hour or send by registered mail. 

    Address : Housing Office, Muak #1, Yonsei University, 50 Yonsei-ro, Seodaemun-gu, Seoul 
              (zip code 03722) 

 B. Submission period: 2018. 12. 26.(Wed) ~ 2019. 1. 3.(Thu) /office hour 9:00~17:00
    The documents must arrive within the period. Late submission is NOT allowed.
 C. Residence related documents  
   ※ Notes 
   1) When submitting, please write down the student’s name & student’s ID number on the
      upper-left corner of each document
   2) All the documents should be original copy.
   3) Personal information of the family members such as ID card number can be hidden.
   4) All the documents submitted must have been issued within a month to be valid.
      (Issued after 1st Dec. 2018) 
   5) Any Missing document or false information will result in failure to register. 

    ◼ For domestic residents, in the case that the parents and students live in the same place

      : A certificate of resident registration
    ◼ In case that one’s father’s address and mother’s address are different 
       : A certificate of resident registration of father, a certificate of resident registration of 

mother, a certificate of resident registration of student and a certificate of family relations 
    ◼ In case that the student is from single parent family 
       : A certificate of resident registration of a parent, a certificate of resident registration of 

student, and a certificate of family relations
    ◼ In case of a foreign resident, please submit a copy of proof of foreign residence of 
       student and the parents
    -  For ‘Proof of foreign residence’ issuance, please contact Ministry of Foreign Affairs
       (02-2100-2114). 
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    ◼ In case that the student’s parents live abroad and the student lives in Korea, please submit
       a copy of proof of foreign residence for parents, a copy of proof of residence for student
       and a certificate of family relations. 

    ◼ In case of foreigners, please submit a copy of passport.

      (You can also submit a copy of alien registration card or a copy of proof of
      foreigner registration.) 
      ※ Only a copy of Certificate for Alien Registration card and a copy of passport 

         can be sent via e-mail. E-mail : muakdorm@yonsei.ac.kr
    ◼ In case of a handicapped student, please submit a copy of certificate of disability.  
       There will be a priority in selection when meeting the eligibility    

5. Result Announcement: 2019. 1. 9.(Wed) 18:00

                               Housing office homepage (http://web.yonsei.ac.kr/housing)

6. Health Inspection

The students selected as the residents in our dormitory must submit the health diagnosis form on 
the date of check-in. The health inspection must include a pectoral X gland(chest X-ray). 
If you avoid the health inspection or are found to be ineligible for community life, your housing 
admission will be canceled.
Failure to submit the health diagnosis form on the check-in date will result in demerits on 
your record. 
 * The valid period for health certificate : within 2 months from a date of check-in.

   (The certificate must be issued after 2019. 1. 1.)

 * A foreign certificate must be translated(into English or Korean) and notarized, so we recommend

   that you use Korean medical institution.

7. Payment period : 2019. 1. 10(Thu) ~ 1. 11(Fri)

8. Check-in date : 2019. 3. 1(Fri), 10:00 ~ 18:00

9. Residence period : 2019. 3. 1(Fri) 10:00 ~ 6. 22(Sat) 12:00

10. Contact number : 02)2123-8419, 3602, 3622
※ The above schedule may change depending on the school’s situation.

Housing Office
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D-2 유학생 비자(석사: D-2-3, 박사: D-2-4)를 발급할 예정인 학생들은 표준입학허가서(합격증과는 다
른 서류입니다. p.3 참조)를 신청해주시기 바랍니다. 다른 비자(A-1, A-3, D-1, D-5, D-9, E-1, E-7, 
F-1, F-6, H-2, 재외동포 비자 등)를 소지하여 입국 및 국내 체류에 문제가 없는 경우, 표준입학허가
서를 별도로 신청하실 필요 없습니다.

※ 유의 사항

  1. 국내에서 학부를 졸업하고 대학원에 진학하는 경우, 기존 비자는 만료됩니다. 

     연세대학교 일반대학원에서 발급한 표준입학허가서를 지참하여 신규 비자를 취득하시기 바랍니다. 

  2. 유학생 비자는 학적변동(휴학, 졸업, 제적 등) 발생 시 비자만료일과 상관없이 학적변동일 기준으로

     만료일자가 수정됩니다. 유학생은 학적변동일로부터 30 일 이내 출국해야합니다.  

“Certificate of Admission”(which is different from the Certificate of Acceptance that can be 
printed out on the Yonsei Portal) is issued only for those of students who will apply for a 
D-2 visa (D-2-3: Master’s, D-2-4: Ph.D). If you hold any other visa(A-1, A-3, D-1, D-5, 
D-9, E-1, E-7, F-1, F-6, H-2, etc.) and can stay legally in Korea, you don’t need to apply 
for D-2.

※ Attention 
1. If you just have finished undergraduate program in Korea and are going to enter our 
school, your old D-2 visa is expired from the date of graduation. Please request for the 
“Certificate of Admission” and obtain a new D-2 visa.  
2. In case of any change in the student’s status(taking a leave of absence, graduation, 
expulsion due to withdrawal or unregistered status, etc.), D-2 visa gets to be expired. You 
must leave the country within 30 days from the date of change in the student’s status. 

비자 종류에 대한 자세한 사항은 링크를 통해 확인 하십시오.
https://www.visa.go.kr/openPage.do?MENU_ID=10102

 Please refer to the following web site for information about the types of Korean visa    
 https://www.visa.go.kr/openPage.do?MENU_ID=10102

 10. Visa Issuance for International Students

YONSEI UNIVERSITY GRADUATE SCHOOL  
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D-2 비자를 신청하실 분들은 2018 년 12 월 31 일 (월)까지 

PDF 파일로 된 재정증빙서류, 여권사본, 사진파일(3.5cmX4.5cm, jpg)을 
chan0214@yonsei.ac.kr(신촌 캠퍼스 소속 학과 합격생) 
acqwj@yonsei.ac.kr(원주 캠퍼스 소속 학과 합격생)
으로 보내주시기 바랍니다. 표준입학허가서는 메일로 발송해드립니다. 

 If you are going to apply for a D-2 visa, please submit a copy of proof of funds, a 

copy of passport, passport size photo (3.5cm x 4.5cm) in jpg format, by December 31th 

(Mon) 2018 to chan0214@yonsei.ac.kr . We will send you the Certificate of Admission via 

e-mail.

1) 비자를 신청하실 분은 메일로 발송해드리는 표준입학허가서와 기타 필수 서류(예: 신청서, 여권, 연
세대학교 사업자등록증 등) 지참하여 대사관(영사관) 방문 및 비자 신청하시기 바랍니다. 

   With the Certificate of Admission and other required documents such as passport, 
application form, etc, please visit the nearest embassy in your country to apply for a D-2 
visa.

2) 한국에서 비자 연장 또는 변경 신청을 하실 분들은 서울남부출입국외국인사무소에 문의 후, 필요한 
제출서류와 함께 (예: 신청서) 여권, 표준입학허가서, 외국인등록증을 가지고 (예약 후) 방문하셔서 비
자 연장/변경 신청을 하시기 바랍니다. (http://www.hikorea.go.kr/pt/main_kr.pt 또는 대표번호 
1345) 

   If you want to extend or change your visa in Korea, please request it to the Southern 
Immigration Office (http://www.hikorea.go.kr/pt/main_kr.pt or just call 1345) about the 
detailed process or required documents. (eg. Application Form) We recommend you to visit 
the office after making a reservation. You will have to bring your passport, alien 
registration card, the Certificate of Admission, etc.

※ 유의사항:　표준입학허가서를 수령하신 후, 반드시 허가서에 나와 있는 정보가 본인의 정보와 일치하는지 
            확인하시고, 틀린 부분이 있을 경우 재발급 요청을 해주시기 바랍니다.
※ Attention
  Please check whether all the information written on the certificate of admission is correct.  
  If there is any misinformation, please request for re-issuance.
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주의: 2018 년 12 월 31 일 (월) 까지 신청을 하지 않으시는 분들은 표준입학허가서가 필요하지 않은 

것으로 간주하겠습니다. 

NB: If you don’t request for the Certificate of Admission by December 31(Mon) 2018, we 
will take it as unnecessary for you.

입시원서를 제출할 때 일부 서류를 제출하신 것을 알고 있지만, 원활한 업무 진행을 위해 다시 한 번 
이메일로 제출 부탁드립니다. 

We are aware that you have already submitted some of the documents when you applied 
to our school, but please kindly send us the documents again via email for progression of 
our work. 
Thank you for your cooperation in advance.

3) 담당자 연락처 Contact information

연세대학교 일반대학원 교학팀 정상찬 
Sangchan Chung
Office of Academic Affairs, Yonsei Gradaute School
Tel) 82-2-2123-3228, Email) chan0214@yonsei.ac.kr 

원주캠퍼스 교무처 교무부 안성혁
Seong-hyeok Ahn
Office of Academic Affairs, Wonju Campus
Tel) 82-33-760-2795, Email) acqwj@yonsei.ac.kr 
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Yonsei University Graduate School

  50 Yonsei-ro, Seodaemun-gu, Seoul 03722, Korea 
Graduate School Office (Stimson Hall 2F)

Tel: Seoul Campus / International Campus : +82-2-2123-3228
            Fax : +82-2-2123-8652

Wonju Campus : +82-33-760-2795
Fax : +82-33-760-2566

Email : ysgrad@yonsei.ac.kr
Website : http://graduate.yonsei.ac.kr


